
Page 1 

Locating and Evaluating 
Information on the 

World Wide Web 

The Library of Rush University 
& 

McCormick Educational Technology Center 
 
Rush-Presbyterian-St. Luke’s Medical Center                                         Telephone: 312 942-5950 
Armour Academic Center, 5th Floor                                                                   Fax: 312 942-3143 
600 South Paulina Street                                                                         Email: Lib_Ref@rush.edu 
Chicago, Illinois 60612 
 

www.lib.rush.edu/library 



Page 2 

What is the Internet? 
 
The Internet is a system of computers linked together so that they can ‘talk’ to each other. Using the Internet, 
the computer on your desk can exchange information with computers across the globe. The Internet began 
during the Cold War as a method to insure military and government communications would survive a nuclear 
attack. At first, only government and university computers were connected. However, as people began to see 
the Internet’s potential, commercial and personal users began to join. There are now millions of places to visit 
on the Internet with thousands of new places added each day. You could even add your own page of 
information if you like! To read more about the history of the Internet, please visit the Internet Society at:  

www.isoc.org/internet/history/brief.shtml 

What is the World Wide Web? 
 
The World Wide Web (WWW) is a system that offers a simple method to navigate the Internet. In the 
beginning, users needed to type in commands to use the Internet. It was a text-based environment without 
images, sounds, or any other of the interactive multimedia content that is now common place. The WWW 
makes traveling the Internet easy. Instead of typing in commands, navigation is accomplished links. Users 
move from one location to another by simply clicking on the link with the mouse. Links are often 
underlined or a different color that the rest of the text. An image can also be a link. You can often tell if 
something is a link by observing the cursor: when it passes over text or images: it often changes to a 
picture of a hand. 

Introduction 
 
The Internet provides a gateway to information about any topic imaginable. Using it to find health care 
information is one of the top reasons people use the Internet. While the benefits of the Internet are tremendous, 
there are a few cautions. It is not hard to find information about a topic on the Internet. With multitudes of new 
sites added each day, you are sure to find something. But is the information correct? The difficulty is locating 
the factual information from dependable resources. The information must be accurate, reliable and current. 

Without the Internet, a computer 
can only access and exchange 
data with a computer connected to 
their own network. 

The Internet allows any computer connected 
to the Internet to communicate with any 
other Internet connected computer. 

PUBLICATIONS  
PUBLICATIONS  

Alphabetic Index of Publications 
[A][B][C][D][E][F][G][H][I][J][K][L] 

The mouse cursor changes to a hand indicating 
PUBLICATIONS is a hyperlink. Clicking on it takes 
you to the page PUBLICATIONS. Hyperlinks are 
created by the person who designed the page and 
sometimes can be wrong or out of date. This is called 
a dead link. 

Clicking on the link Takes you here 
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How Do I Connect to the Internet? 
 
Office (Medical Center or University) 
If your office computer is connected to a local network that provides access to the Internet, you are already 
connected. If you need help, contact your supervisor. Most computers here at Rush are connected to the 
Internet.   
 
Home 
To access the Internet from your home, you must first select an Internet Service Provider (ISP). An ISP is a 
company or organization that provides a gateway to the Internet. One method is to use your computer’s modem 
to dial into your ISP’s computer network using a telephone line. This is called a ‘dial-up account’. Other 
methods use cable modems, which share the same cable access as your cable TV. DSL is similar to a “super” 
telephone connection using a special modem. 
 
Both cable modem and DSL are often called Broad Band Access because they process transfer data from the 
Internet to your computer faster than a telephone dial-up account. You notice this when working with large 
files, graphics, and online searching. There are many variables that can account for how fast your connection to 
the Internet works: the number of people using the Internet at the same time, the quality of your computer or 
the one you are connected to, etc. In general, cable modems and DSL service can move than 1 to 3 megabytes 
of data per second from the Internet to your computer. A typical telephone modem dial-up connection is lucky 
to move 56 kilobytes worth of data per second. 
 
Some ISP’s provide Internet service free such as schools and universities.  (Rush provides free dial-up service: 
contact Information Services at 942-HELP for details). Most ISP’s charge for access. Examples include 
America Online, Interaccess, etc. To find an ISP in your area, talk with friends in your area. To learn about the 
Internet services provided by Rush to access the Library Resources from your home, ask for the Library’s 
handout about Home Access.  

What is an Internet Address? 
 
Universal Resource Locator (URL) 
This is the address you use to tell your browser where to find a particular Internet resource. For example, the 
URL for the Library of Rush University is http://www.lib.rush.edu/library. The components of this address 
are: 
 
http://                    http:// stands for Hypertext Transfer Protocol. Indicates that you are using the World Wide 

Web features of the Internet.   
 

www.lib.rush       The location of the Server (computer you are connecting to). Rush is the main computer and 
lib stands for the Library’s own server connected to the Rush Network. 

 
.edu                      Called a domain name; it indicates the general type of source. Common domain names 

include:  .mil        military                              .gov       government 
.edu       education                           .com      commercial 
.org        organization                       .net        net (usually commercial) 

 
/library                 The slash indicates that what follows is a file on the computer your are connecting to. In this 

example, the file is the Library file on the server of the Library. This is where we store our 
home page information. 

 
Internet Protocol (IP) Address 
The IP address identifies what server you are using to connect to the Internet. An IP address can be numeric or 
text: http://144.74.100.150/library/ is the same address as sunlibrary.is.rpslmc.edu. 
 
Some services on the Internet can only be used by people dialing in to a specific computer. The service 
examines the IP address to see if it is allowed access. For example, due to licensing restrictions with publishers, 
very few resources from the home page of the Library can be used by people who are not connected to the Rush 
Network. If you try to use these services when you are connected to a different server such as America Online, 
you will be denied access. 
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What is a WEB Browser? 
A web browser is a software program used to navigate the Internet. A browser allows users to move around the 
Internet using links. From a browser, you can view images, print information, listen to sounds, etc. There are 
several browsers on the market such as Netscape or Microsoft Explorer. The examples in this handout are from 
Internet Explorer 5.5. Similar features and tools are available from most browsers. 
 

What is a Web Page? 
A web page is a block of data available on the World Wide Web identified by a URL. It is constructed using a 
program languages. A common one is called Hypertext Mark-up Language (HTML); the are others you may 
run across. A web site is a collection of web pages. The starting page for navigating a web site is called the 
home page.  

Internet Explorer 5.5 Web Browser 

Window’s Title Bar  Menu Bar 

Tool Bar 

Location Bar 

Personal Folders 

Danger: Viruses! 
 
A virus is a malicious program designed to damage your computer. They hide in data 
you download to your computer. Be safe! Whenever you download information, do 
not open the file until you have checked the contents with a virus checking 
software program. Also, even if you know the sender, do not open email 
attachments without checking for viruses first. Check your entire computer for 
viruses often. 
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The Menu Bar 

Edit 
Cut, copy, paste, select all information from a web page and move to a 
Word document, e-mail, etc.  

File 
Save pages, print pages, close the program, 
send the page or URL for the page to 
someone by e-mail.  

Use this option to find a word or phrase 
appearing anywhere on a web page. 

View 
Select what toolbars you wish to display and 
see information about how the page was 
constructed. Make the Page fonts bigger 
(Text Size). 

Sometimes a page can get stalled when 
loading. If it freezes or doesn’t look proper, 
click on Reload. 

Favorites 
You can bookmark you favorite places on the 
Internet, places you’d like to return to without 
having to retype in the Internet address each 
time you wish to revisit them. These are called 
favorites. 

By default, there are six pull down 
menus in Internet Explorer. However, 
you can customize your display. 

Tools 
Tools help you use your browser to 
link over to your e-mail program, 
new group reader, update Microsoft 
Windows products and more. You 
can also set your web browsing/
Internet options. 
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Library of Rush University has the following 
structure: 
 
http://144.74.100.150/library/ 
Image: http://144.74.100.150/library/redline.gif 
Image: http://144.74.100.150/library/greenline.
gif 
Image: http://144.74.100.150/library/redline.gif 
Image: http://144.74.100.150/library/rushl.gif 
Image: http://144.74.100.150/library/redline. 

Cookies 
 

A cookie is a small string of data deposited into a file on your computer’s hard drive from a web site you 
visited. The cookie provides information about your activities on the Internet to other web sites. Some cookies 
help a web site recognize you so that you do not have to enter your password every time you go to the site. 
Other cookies identify the types of sites you visit so that merchants can display targeted advertisements. Some 
people consider this an intrusion of their privacy. Depending on how the web site was constructed, you may not 
be able to use any of the features without allowing the site to place or read cookies. For example, many 
database need cookies ‘enable’ to work properly when you search. 
 
Most browsers allow you to configure how you would like to deal with cookies. The default is to accept any 
cookies and let anyone view your cookie file. You can completely disable cookies meaning no one can place a 
cookie on your computer. Alternatively, you can set it up so that only the company who placed the cookie can 
read it. Whichever option you choose is up to your own personal preference. 
 
To change you cookie settings, go to the Menu Bar of the web browser and locate Tools: Internet Options 
Security and follow the online help. 

For Advanced Users: 
 
The cookie file on your computer is called cookie.txt and can be edited using any word processing software. To 
get rid of unwanted cookies, open the cookie file with your word processor and delete items you wish removed. 
Caution: before you remove a cookie with log-on information, make sure you know the passwords. 

<HTML> 
<HEAD> 
<TITLE>Library of Rush University </TITLE> 
</HEAD> 
<BODY BACKGROUND="" BGCOLOR="#e" 
font size="-2"> 
<table> 
<tr> 
<td valign ="top" rowspan="2"> 
<FONT COLOR="330066"><FONT SIZE="+4"> 

Source and Page Information 
 

This is a sample showing the code some people use to create a web page. 

Source Code (HTML) Properties 

This shows a folder where 
cookies are stored and 
some of actual cookies  
Some are from advertisers 
I may not want, other are 
from places like Journals, 
that remember my login 
information, or Amazon.
com that remembers what 
books I like to read. Not 
all cookies are bad. 
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Navigation Bar 
The Tool Bar provides helps you browse through the Internet and perform common tasks. 

Go to the next or previous web 
page you have visited 

Reload a web page if is stalled 
or doesn't appear correctly 

Takes you to the home page you 
specified in the preferences. 

Takes you to Internet’s 
Explorer’s tools for searching 
the Internet. 

Show a list of sites you have listed. 
Like a trail of bread crumbs, you 
can retrace you steps back to a site 
you visited previously. 

Location Bar 

Print the page.. 

See the coding that went into 
making the page. 

Stop the current page from 
loading. 

The Address Bar shows the URL of 
the site you are visiting. 

Favorites 
Favorites are a simple way to connect to web sites you visit often. When you visit a site you would like to 
return to, click the Favorites Icon (Favorites are sometimes called Bookmarks in other applications). You can 
file the web site name and address in favorite file, organizing it like a phone book. When you wish to visit that 
site later, open your Favorites file and click on the name of the site. Consult your web browser’s instructions 
for more details. 

Can be configured to bring up 
your e-mail program. 

Brings up your list of bookmarks, 
sites you saved the address to so 
that you do not have to re-enter the 
address to revisit them in the future. 

Sample of one person's r Favorites 
file. It is organized by a folder at the 
top  for Medical web site (abbreviated 
MED to save space) and then divided 
by topics Guidelines: Clinical Trials. 
Under that division are the actual web 
sites such as the NIH and HSTAT. 
Clicking on any of these will take you 
right to the site without having to type 
in the web address. 
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Printing, Saving to Disk and Graphics 
 
To copy some text from a page: 
              1. Select the text.  
              2. Choose Copy from the Edit menu.  
 
              Usually, you can paste the text into other files. 
 
To copy a link (URL) from a page: 
               1. Right-click the link or image to display a pop-up menu.   
               2. Choose Copy Link Location or Copy Image Location. If an image is also a link, you are offered 
              both options.  
 
              You can paste the link into other files or into Navigator's Location field. 
 
Saving a Page 
To save an entire page, choose Save As from the File menu. When you view a page containing frames and a 
frame is currently selected, the File menu's Save Frame As option is offered in addition to Save As. This lets 
you save only the page within the selected frame. Saving a file onto your hard disk lets you view the page (or 
its HTML code) when you're not connected to the Internet. 
 
To save an image from a page: 
               1. Right-click the image to display a pop-up menu.  
               2. Choose Save Image As.  
              ! Some people block you from doing this if they do not want their images downloaded from their site. 
              Also be sure to observe copyright laws when downloading any information from the Internet. 
 
Printing a Page 
To print the current page, click Print. On Windows, you can choose Print Preview from the File menu to see 
how the printed page will look. Note: When you view a page containing frames, the File menu contains Print 
Frame in place of Print. To set up the page layout for printing (optional): 
 
               1. From the File menu, choose Page Setup.  
               2. Choose page layout options, including header and footer information.  
 
              Important: Navigator formats content according to the size of the printed page, not the size of the on 
              screen window. Text is word-wrapped and graphics are repositioned to accommodate paper size. 

Searching Within a Page 
  
To find text within the page you are currently viewing: 
 
              1. From the Edit menu, choose Find in Page. If the page you are viewing contains frames, you may 
              need to click within a frame first.  
 
              2. Type the text you want to find.  
 
              3. Select the "Match case" check box if capital letters should be matched.  
 
              4. On Windows, select Up or Down to search from the beginning or end of the page. If there is a 
              current selection, the search begins at the selection and does not wrap around to the beginning of the 
              page.  
 
              5. Click Find Next to begin the search.  
 
              To find the same word or phrase again click Find Next again (Windows only), or open the Edit menu 
              and choose Find Again.  
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Error Messages 
While navigating the Internet, you may occasionally receive an error message. 

You are trying to enter an area that the web 
site manager does not want you to visit or the 
web master has incorrectly set up the site. 
Refer back to the section on IP address. 

The file you tried to access was not found. 
The web site manager may have moved or 
deleted the file. Also, check to see if you 
made a typo. Consider moving up one level 
in the URL address you entered. For 
example: 
 
If you type in http://www.lib.rush.edu/
library/ovideweb and receive the 404 error 
message, try removing the last file in the 
address (/ovidweb). Re-type the URL as 
http://www/lib.rush.edu/library. By going 
up one level, you may be able to see where 
the file has moved. 

The server (computer you are 
trying to connect to) could 
not be found. In this example, 
the browser could not locate 
the server at the address 
library.rush. Check your 
spelling for typos. 
 
Also, check the domain name  
(.edu, .org, .gov, etc.) to see if 
you entered the correct one.   

Please keep in mind that the Internet is a dynamic environment. Web sites are 
added, removed and changed constantly. URL’s become out dated quickly. 
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Beginning A Search 
 
1) Define your question: What exactly do you want to know when your search is completed.  
 
2) Decide if the Internet is the best resource to answer your question. Many questions are better answered using 
materials such as textbooks or specialized databases such as MEDLINE. Remember: not everything is on the 
Internet. 
 
3) Break your question into components. Identify the keywords that describe your topic and think of any related 
synonyms. For example, if you are looking for information on cancer, in addition to the word cancer, consider 
adding neoplasm, tumor and other related words to your search also.  
 
4) Select the best search tool. Do you need a search engine, subject index, etc? 
 
5) Watch your spelling. Spelling errors are the most common reason for poor results. 
 
6) Run your search through several search tools. The average search engine covers only a small fraction of the 
information available on the Internet. Frequently, the exact same search run on different search engines will 
find different results. If you cannot find what you are looking for using one search engine, do not quit. Try 
another search tool. 

Search Tools 
 
There are many different tools you can use to search for information on the Internet. Here is a brief description 
of the types of tools available and a few examples: 
 
Links From A Home Page 
Many web sites include a list of links to related subjects. This is often a fast and easy method to find related 
information. Home pages with good related links include Professional Societies, Libraries and Government 
Pages.  
 
The Library of Rush University                                     http://www.rush.lib.edu/library. 
The American Academy of Family Physicians            http://www.aafp.org/sites/ 
 
Subject Directory  
A subject directory arranges sites by topic. A group of people looks through web pages and decides what 
categories they best fit. Since the actual site has been looked at and reviewed, a subject directory usually a good 
place to start your search. However, because of the work involved in looking at each site, not every site on the 
Internet is in their index. In addition, it takes time for new sites to be entered into the index. 
 
Example: 
Scirus                                                                             http://www.scirus.com/ 
Yahoo                                                                            http://www.yahoo.com 
Yahoo Health                                                                 http://health.yahoo.com/ 
On Health                                                                       http://www.onhealth.com/ch1/index.asp 
Web MD                                                                        http://www.webmd.com/ 
Medical Mega Site                                                         http://henry.ugl.lib.umich.edu/megasite/toc.html 
HealthFinder                                                                  http://www.healthfinder.gov/ 
Combined Health Info Database                                    http://chid.nih.gov/ 
Healthgate                                                                      http://www.healthgate.com/ 
Health Web                                                                    http://healthweb.org/ 
 
Search Engine 
A search engine uses an “agent” (sometimes called a spider or crawler) that travels across the Internet visiting 
various home pages. They send back information about the sites to the search engine that adds this data to their 
index. When you use a search engine, you are actually searching that search engine’s index, not directly on the 
Internet. 
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Since there are many ways to configure the agents and indexes, each search engine contains different data. 
Recent studies suggest that most search engines only cover about 20% of the information on the Internet. Also, 
there is very little over-lapping. Experienced searchers run their search strategies through multiple search 
engines. 
 
Search engines use complex algorithms to rank the results of your search. They put the most relevant results 
first in the list. They rank relevancy by looking at if the words appear in the title, are near the top of the page, 
how many times the word appears in the page, if the words you are searching appear together (adjacent) to each 
other, etc. Practically, this means that although your search may turn up hundreds of hits, the ones at the top 
will be your best choices. Many search experts suggest looking at only the first 20 - 50 hits of your search.  

 
Boolean logic 

To create an effective search, you often have to use combinations of terms. Boolean Logic uses the terms and, 
or to combine terms. Using And means the terms must appear together. Or means they can appear in either set 
and do not have to be together. And makes smaller sets, Or bigger ones.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Each search engine has its own way of handling Boolean operators. To insure that the engine uses the operators 
the way you want, read the instructions. 
 
Most search engines also work with using the + (plus) and – (minus) signs.  + Means the word must be in your 
results.  - Means the word cannot be in your results. 
 
To look for a phrase, place your terms between quotation marks in the correct order: 
“american academy of pediatrics” 
 

 
A Sampling of Search Engines 

 
Each Search engine has its own features. Before using any search engine, you should read the instructions. In 
addition, here are a few sites that provide useful information about how to search the Internet: 
 
Search Engine Watch                                      http://searchenginewatch.com/ 
University of Albany                                      http://www.albany.edu/library/internet/ 
 
 
 
 

Results 

AND OR 
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Search Engines: 
Google                                                            ht.//www.google.com 
Hotbot                                                             http://www.hotbot.com/ 
AltaVista                                                         http://altavista.digital.com/ 
Excite                                                              http://www.excite.com/ 
Lycos                                                              http://www.lycos.com/ 
 
Meta Search Engine 
We have suggested using multiple search engines when you search the Internet. Meta Search Engines do this 
for you. A Meta Search Engine takes your search strategy and sends it to a number of search engines. It takes 
the results from all the engines and then creates a ranked list. While they are very convenient, keep two things 
in mind. First, if they cannot reach one of the search engines in their list or that search engine is running slow, 
the Meta Search Engine skips that search engine. In addition, the Meta Search Engine only takes a limited 
number of results from each engine- typically 10 - 50 results. 
 
MetaCrawler                                                   http://www.metacrawler.com 
DogPile                                                           http://www.dogpile.com 
 
Natural Language 
Up to now, the search engines we have discussed require you to translate your question into a search strategy. 
Several services are taking a different approach. The Natural Language search engine simply asks you to enter 
you question as a normal sentence. For example: “Where can I find statistics on colon cancer in men over the 
age of 40.”  The Natural Language search engine parses your sentence, creates its own strategy and gives you 
the results. 
  
Ask Jeeves                                                      http://www.aj.com/ 

Evaluating Information Found on the Internet 
 
How can you trust the information you have found on the Internet? Nothing is fool-proof; however these tips 
may help* 
 
Purpose 
 
              Audience: 
              Consider the intended audience of the page, based on its content, tone and style. 
              Does this mesh with your needs? 
 
              Consider the Source 
              Web search engines often amass vast results, from memos to scholarly documents. 
              Many of the resulting items will be peripheral or useless for your research  
 
Source 
              Author/producer is identifiable. 
              Author/producer has expertise on the subject as indicated on a credentials page. You may need to   
                             trace back in the URL (Internet address) to view a page in a higher directory with background 
                             Information. 
              Mail-to link is offered for submission of questions or comments. 
              Sponsor/location of the site is appropriate to the material as shown in the URL Examples:  
                                           .edu for educational or research material  
                                           .gov for government resources  
                                           .com for commercial products or commercially-sponsored sites  
                                           ~NAME in URL may mean a personal home page with no official sanction  
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Need More Information? 
 
To learn more about the features of your web browser, read the online help instructions. They can usually be 
found under the menu bar on the far right of your web browser. 
 
Visit one of the Internet tutorial sites on the Internet. The University at Albany Library’s web site has excellent 
information: http://www.albany.edu/library/internet/.   
 
For help with a search engine, look for their online help link. Since search engines change rapidly, it is a good 
idea to check the instructions on a regular basis. To see tips on how to use search engines in general, visit 
Search Engine Watch at http://www.searchenginewatch.com  They provide information for all skill levels, 
beginner to advanced. 
 
The Library has an excellent collection of books about using the Internet. Some of them specifically address 
using the Internet to find medical information. Please contact the Library or search the online catalog. Our 
home page, http://www.lib.rush.edu/library, provides valuable links for beginning a search. 
 
Finally, please do not hesitate to contact the Reference Desk. We will gladly assist you with any questions you 
may have. 
 

The Library of Rush University 
(312) 942-5952 

libref@rushu.rush.edu 

Content 
 
              Accuracy  
              Don't take the information presented at face value  
              Web sites are rarely refereed or reviewed, as are scholarly journals and books  
              Look for point of view or evidence of bias  
              Source of the information should be clearly stated, whether original or borrowed from elsewhere  
 
              Comprehensiveness  
              Depth of information: determine if content covers a specific time period or aspect of the topic, or 
              strives to be comprehensive  
              Use additional print and electronic sources to complement the information provided  
 
              Currency  
              Look to see if site has been updated recently, as reflected in the date on the page, and material 
              contained on the page is current  
 
              Links  
              Links are relevant and appropriate  
              Don't assume that the linked sites are the best. Investigate additional sites on the topic  
 
Style and Functionality 
              Site is laid out clearly and logically with well organized subsections  
              Writing style is appropriate for the intended audience  
              Site is easy to navigate, including clearly labeled Back, Home, Go To Top icons/links 
              Internal indexing links on lengthy pages  
              Links to remote sites all work  
              Search capability is offered if the site is extensive  
 
* Created by Trudi Jacobson, Coordinator of User Education Programs and Laura Cohen, Network Services 
Librarian, University at Albany Libraries http://www.albany.edu/library/internet/evaluate.html 
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Bonus: Connecting to  
the Library From Off Campus 

The students, faculty, and staff of Rush University and Medical Center may access restricted 
Library resources such as our full-text journals, databases, and electronic textbooks from off 
campus by using a special computer account called a Proxy. A Proxy account only works 
with your existing Internet service provider: you must have a cable, DSL, or dial-up account 
first.  
 

� The Proxy account does not give you access to the Internet- you must have your 
own Internet Service Provider such as AOL, AT&T, SBC, etc.  

 
� The Proxy account works with America Online (AOL) service. However, it does 

not work with AOL’s proprietary web browser. To use the Proxy account with 
AOL, please download/use the most current version of either Microsoft Internet 
Explorer or Netscape Navigator web browser.  

 
� The Proxy account is compatible with Macintosh operating systems.  

 
� Before using your Proxy account, you must make a one-time, simple set-up 

change to your web browser. Details are available at our web page:  
                                     www.lib.rush.edu/library/proxyins.html 

 
� Your Proxy account allows you to access restricted Library resources including 

our full-text journals, databases, etc. You can also leave the Library web site and 
visit other internet sites. However, the Proxy account does not give you access to 
other restricted Rush web resources such as e-mail, the Rush Intranet (IRIS), 
patient information, lab results, etc. These are different accounts and are not 
related to the Proxy account. 

 
To apply for a Proxy account, visit: www.lib.rush.edu/library/proxy.html 

 
For help using your Proxy, visit: www.lib.rush.edu/library/contactpxy.html. 

 
 
 

If you need an Internet Service Provider, you can apply for 
a Rush Dial-Up account atwww.lib.rush.edu/library/dialup.html 

 
 
 

The Library of Rush University                                  Main Telephone:         (312) 942-5950 
600 South Paulina, 5th Floor                                      Reference Desk:          (312) 942-5952 
Chicago, Illinois 60612                                               Fax:                             (312) (942)-3143 
E-Mail: Lib_Ref@rush.edu                                        Home Page: www.lib.rush.edu/library 


